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Introduction 
Revit Structure users can now leverage the full power of Building Information Modeling by synchronizing their Revit 
Structure models with RISA-3D and RISA Floor. As an Autodesk Authorized Developer, RISA Technologies has created a 
full-fledged bi-directional exchange link with Revit Structure. 

New models can be created in either REVIT Structure or RISA software using the information available in the other program. 
All geometric and design information including materials, family instances, walls, slabs, openings, grid lines, boundary 
conditions, footings, loads and load combinations can be created / updated / deleted in either of the two programs using the 
information available in the other program. 

The new exchange file method allows continuity of data flow throughout the exchange cycle. Users can add new elements 
and/or additional design to the RISA model and these changes will be retained in RISA while round-tripping. 

The robust Excel based XML mapping file provides the capability to customize the processing of shapes, materials and load 
cases. A log file is created during every export / import operation giving a synopsis on the number of elements translated and 
errors/warnings encountered. 

 

Why Revit Structure and RISA ? 

Imagine relocating a stairwell in an office building – re-framing, redesigning, updating drawings.  In the past, a task like this 
would have taken hours.  Likely you would re-frame plans and hand mark-ups to the draftsman.  While new framing was 
making its way onto the plans, you’d manually update the analytical model, rerun the analysis/design, then pour over the 
results.  With a new design in hand, you’d tag new sizes on the updated plans, spending more time than you’d like cutting 
sections. 
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 With Revit Structure, you’re already ahead of the curve.  Every change – be it new framing, sizes, decks, notes – is 
automatically updated on all drawings in your set.  Even sections!  If only the same were true for your analysis software.  
With the latest versions of RISA programs and Revit Structure it is!  Now you have the full power of RISA programs behind 
every step you make with Revit Structure.  Export the entire Revit Structure model, or just a selected subset, to either of the 
RISA programs.  Perform static or dynamic analyses, moving load analyses, vibration loading, live load reduction, 
automatically generate seismic and wind forces, design elements using provisions from various countries and tie the results 
back to your Revit Structure model.  See the results...on the drawings and in your project budget. 

Install the RISA-Revit Structure Link Component 

You already have Revit Structure and at least one RISA program in the office.  In order to take full advantage of both 
programs you’ll need to install the RISA-Revit Structure Link Component. 

1. Login to Windows – your account must allow registry access privileges 
2. Exit out of Revit Structure and all RISA programs 
3. Locate the Link Component installation file in one of three locations 

o Autodesk® Revit® Structure installation CD 
o Autodesk® Buzzsaw® website 
o RISA Technologies website 

http://www.risatech.com/partners/prt_revit.html 
4. Run the self-executing installation file RISARevitLink2010.exe  

  

The RISA-Revit Link will be installed in a new subfolder (RISA Revit Link) within the RISA installation directory. 

In addition, the installation routine modifies the Revit.ini file to include the RISA-Revit Structure Link.  This file is located in 
the Revit Structure program directory (default C:\Program Files\Autodesk Revit Structure 2010\Program\). Modifying the 
INI file helps in creating the Revit Structure menu commands for the link. An example of this modification is contained in 
the Revit_ini.txt file. 
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Version Information 
Component Information 

RevitRISAComponentVersion 8.0 

Compatibility Information 

Product Version 
REVIT Structure 2010 

RISA–3D 8.0.3 or Higher 

RISA Floor 4.0.3 or Higher 

Download Links 

RevitRISAComponent www.risatech.com/partner/revit_structure
.asp 

REVIT Structure www.autodesk.com 
RISA – 3D www.risatech.com/risa-3d.asp 
RISAFloor www.risatech.com/risafloor.asp 
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Getting Started 
Export Revit Structure Model to RISA-3D or RISAFloor 

In Revit Structure, to export your model to any RISA program, save your model and open a 3-D view then go to: 

Add-Ins > Export to RISA... 

 
The Export Window will appear (below) with several options 
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RISA Products 

The RISA Products section is used to select a RISA Program (default is RISA-3D) 

Export Options 

Launch Program / Write to File 

Launch Program will create a new RISA model and launch the RISA program. In contrast, Write To File will save the 
model to a file that can later be opened in RISA.  

The Export Selected Items Only checkbox will create the model using only the currently selected elements in Revit 
Structure.  When unchecked, the entire Revit Structure analytical model is exported.  

The user has the option of exporting only those elements currently selected in the Revit Structure model.  This can be useful 
when analyzing a substructure such as a series of frames or a truss, for instance, without exporting the entire model. 

Tolerances  

The user can specify a Merge Tolerance and a Footing Tolerance value. The Merge Tolerance value is provided to take into 
account the discrepancies while modeling in Revit Structure. Any points/ elements/ loads defined within this tolerance limit 
will be snapped to the same location. Footings located within this tolerance distance of a column will be snapped back to the 
column node in RISA.  Footings outside of the tolerance distance will be ignored. 

Redesign Members 

In RISA Floor, there is also an option to ‘Redesign Members’. If this option is checked, the corresponding design list is 
automatically selected as the ‘Shape Type’ for each column and beam in the structure. This facilitates their design in RISA 
Floor. If this option is not checked, the shape names are explicitly exported to RISA Floor. 

Export Slab Perimeters and Openings 

Finally, there is an option to export ‘Slabs and Opening Perimeters’. If checked, it instructs the link to run around all defined 
decks and openings in Revit Structure and find a closed  polygon of supporting framing around them. If closed framing 
polygon is found, it automatically creates slab perimeters and openings in RISA Floor. 

File Names 

 Here, the engineer selects a RISA program to accept model data from Revit Structure, with the option of either exporting 
directly to RISA or writing to a file.  By default, the Link Component will write an exchange and base files in the default 
RISA directory (typically C:\RISA) using the same Revit filename. 

The Exchange File Name designates whether you want to use an existing exchange file or specify a new exchange file 
name.  

The Base File Name selects an existing base file. Leave this entry blank to create a new base file. 

  

When you click “OK”, the Link Component will create a RISA exchange file from the current Revit structure model.  For 
larger models, this may take a few moments – you should see a progress bar similar to the one below. 
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If the WRITE TO FILE option is selected, the engineer will need to manually import the exchange file into the RISA 
program.  To do this in the RISA program, select: 

File > Import > BIM Exchange File 

 
After importing the BIM Exchange File, RISA automatically creates a corresponding .r3d / .rfl base file (depending on the 
RISA program) in the working directory.  This base file can be saved to any directory location – it’s path is correctly written 
to the exchange file during BIM Exchange File export (see next section). 

Update From RISA-3D or RISFloor to Revit Structure 

Be sure to save your work in the RISA program.  Performing Save or Save As… will save your changes to the base file, but 
will not create an exchange file.  To update the existing exchange file (or create a new one), you must export a BIM 
Exchange File. 

To do this in the RISA program, select: 
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File > Export > BIM Exchange File 

 
If the exchange file was created successfully, an export confirmation dialog appears. 

 
Note:  

• The default BIM import/export directory can be set using the Tools > Preferences menu of the RISA program. 
Go back to Revit Structure and import your changes from the RISA program.: 

Tools > External Tools > Import from RISA... 

 
The Update From RISA Window will appear (below) with several options 



RISA Revit 2010 Link 

16  

 
  

RISA Products  

The RISA Products section is used to select a RISA Program (default is RISA-3D) 

Import Options 

Merge Tolerance   

The user can specify a Merge Tolerance. The Merge Tolerance value is provided to take into account the discrepancies 
while modeling in Revit Structure. Any points/ elements/ loads defined within this tolerance limit will be snapped to the same 
location.  

Create / Update / Delete  
Select RISA elements to be imported back to RevitRevit Structure.  
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File Names 

The Exchange File Name specifies the target RISA exchange file.  

If the exchange file has a corresponding Base File, then it would automatically be shown in this text box. 

  

When you click “OK”, the Component Link scans the RISA file and creates, updates and deletes selected elements in Revit 
Structure.  As before during Export, a progress bar will appear while importing larger models. 
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Data Exchange 
REVIT Structure TO RISA-3D 

Grid Lines 

Horizontal and vertical lines are supported along with their labels.  While grid lines in REVIT Structure have their own finite 
start and end location, RISA-3D’s grid lines in each direction span between the most extreme grid points in the respective 
opposite direction. 

Columns, Beams, and Braces 

Family instances with structural usages of column, beam, and braces are supported.   The following properties are supported; 
rotate angle, material type, family type name, start release code, end release code, structural type, and element ID. Redesign 
Lists for all members created from REVIT Structure elements are set to “None”. 

In-Place Families 

In-place families are supported. In-place families with multiple curves or non-linear curves are supported. In order to 
export/import member information (member shape name, rotate angle, material type, start-end release etc.), the individual 
members constituting an in-place family must be defined as individual family instances (Components).  

In all other cases, ie, lines, massings etc. only geometry information will be exported. No information would be updated in 
this case. 

Footings 

Family instances with structural usage of footing are supported.  The length, width, and thickness properties of the footing are 
supported.  The footing location point must be at the same location as a RISA-3D joint.  Examples of this would be at the 
base of a column, beam, brace, or wall corner location.  Footings defined without being attached to the structure will not be 
brought into RISA-3D.  Physical material properties and rebar data are not brought into RISA-3D at this time.  Footing 
rotations applied in REVIT Structure will be supported if they are aligned with the rotation of the column. 

Boundary Conditions 

Point Boundary conditions are supported. The X, Y, Z translation and rotation are supported. If the boundary condition is 
specified as a spring, then the spring modulus is also supported. 

Pinned end conditions are automatically added to the bottom of each column stack. A column stack consists of all columns 
lying in the same vertical line. If the bottom of a column stack intersects a beam/ girder or a wall, then no end condition is 
assigned in this case.  

Pinned end conditions are also automatically added to walls having no elements below or intersecting their lowermost 
surface. If the lowermost surface of the wall intersects with a beam or the top of another wall, or any column or brace lies 
below it, then the automatic assignment of end conditions is not carried out. 

Structural Walls 

Structural walls of all types except “Non Bearing” are supported.  REVIT Structure walls are transformed into 4 node plate 
elements in RISA-3D. For a wall polygon with more than four edges defined in REVIT Structure, its bounding rectangle 
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would be created as a wall panel in RISA-3D. The wall thickness is translated into the wall panel thickness. Structural walls 
are transferred to RISA as 'General Material' wall panels. 

Materials 

All steel, concrete and wood materials defined in REVIT Structure are translated into corresponding RISA materials. Any 
other materials (generic etc.), if associated with the walls in the current project are also read into RISA-3D. Materials 
associated with walls are specifically generated under the ‘General’ Material category to match the internal defaults in RISA-
3D. However, the properties of these wall-specific materials might be specified to match any material type.  

All Materials use the Material Spreadsheet on the Mapping File. If a mapping is found on the Materials Spreadsheet of the 
Mapping File, the material properties are preserved in RISA software. If no mapping is found in the mapping file, then new 
materials are created in RISA-3D using the name and material properties available in REVIT Structure. 

Load Cases 

Load Cases are directly translated into RISA-3D Basic Load Cases.  Load case labels are brought over and used to assign all 
the REVIT Structure loads into the proper RISA-3D basic load cases.  REVIT Structure Load Case Natures are not currently 
translated into RISA-3D categories. 

Load Combinations 

Load Combinations are directly translated into RISA-3D Load Combinations.  Load Combination Labels, Load Case 
references, Load Case factors are all considered.  The combination type is brought over as the RISA-3D solve or envelope 
flag.  The combination state is brought over as the RISA-3D service flag.  REVIT Structure Load combinations are flagged to 
apply to all materials. 

Load Combinations inside other Load Combinations are translated into RISA 3D. Please note that RISA 3D supports linking 
only up till one level deep. Any further linking would not be brought over into RISA 3D. 

Point Loads 

REVIT Structure point loads are translated into either RISA-3D joint loads or RISA-3D member point loads, depending on 
whether the REVIT Structure point load is placed on a joint or on a member.  Point loads that are not located on either a joint 
or a member are not translated. 

The local coordinate system flag is not being considered at this time as it appears to have no affect on the loads within 
REVIT Structure. 

Line Loads 

REVIT Structure line loads are brought over as RISA-3D member distributed loads.   Any part of a REVIT Structure line 
load that is co-incident with a member will be translated.  REVIT Structure load do NOT have to start and end on the 
member’s ends, and can be fully within or outside the member’s start and end points.  Line loads that span multiple members 
will have the appropriate part of the load applied to each member.  The local coordinate system flag is not being considered at 
this time as it appears to have no affect on the loads within REVIT Structure. 

Area Loads 

REVIT Structure area loads are translated into either 3 or 4 point RISA-3D member area loads.  Any  area loads with more 
than 4 points are not currently considered.   The local coordinate system flag is not being considered at this time as it appears 
to have no affect on the loads within REVIT Structure. 
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RISA-3D TO REVIT Structure 

Grid Lines 

Horizontal and vertical grid lines are supported along with their labels. All grid lines that are horizontal or vertical are over-
written, where as all others are preserved. 

Columns, Beams, and Braces 

Members with ‘Type’ set to Column, Beam or Brace are supported. These elements are created if they are not existent in the 
current REVIT Structure project. If an existing element is found, its geometry and properties are updated. If an element was 
deleted in RISA, it would be automatically removed from the REVIT Structure project. The geometry, location, shape name, 
rotation, material information and function of family instances can be updated from RISA to REVIT Structure. 

RISA-3D shape names are mapped to families corresponding to shapes in REVIT Structure via the shape mapping file. If a 
family corresponding to a particular shape is not already existent in the current project and the auto-load option is checked on 
the Import Dialog, then the link will run through all available REVIT Structure families. If a match is found for the newly 
imported shape, then the corresponding family would be automatically loaded in the project.  

If a shape name is in both a Column and Beam family in the REVIT Structure project, then it would be distinguished by the 
presence of the “Column” keyword in the Column family and “Framing” keyword in the Framing Family.  

Footings 

The link would create, update and delete isolated footings in REVIT Structure. The location, max length, max width, and 
max thickness entered in RISA-3D would be used to update the location and properties of footings in REVIT Structure. The 
footing size obtained after solution in RISA 3D willt be sent back to REVIT Structure.  

Boundary Conditions 

Point Boundary conditions are supported. The X, Y, Z translation and rotation are supported. If the boundary condition is 
specified as a spring, then the spring modulus is also supported. Boundary conditions would be created, updated and deleted 
from RISA to REVIT Structure. 

Structural Walls 

Wall panels and openings in RISA are transferred to REVIT as structural walls. RISA wall panels must be rectangular, 
oriented vertically, and can only have four corner nodes. Wall panels and openings are created, updated and deleted from 
RISA to REVIT Structure. Vertical plates in RISA will also transfer as structural walls in REVIT. 

The material associated with the walls in RISA software are mapped over as ‘WallType’ in REVIT Structure. ‘WallType’s 
are mapped over using the Material Mapping Spreadsheet in the Mapping File. If a mapping does not exist in the mapping 
file, the link will try to map the name as it exists in RISA software. If however, this name is not found in REVIT Structure, 
“Generic” wall types would be used. If an existing “Generic” WallType is not found, a new “Generic” WallType is created. If 
a WallType exists and holds a valid material, the properties of this material would be updated using the properties of the wall 
panel in RISA software.  

Materials 

All steel, concrete and wood materials available in RISA software are translated to REVIT Structure Materials. Any other 
materials (generic etc.), would be updated only if they are associated with a ‘WallType’. Materials are created, updated and 
deleted from RISA to REVIT Structure. 
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Materials are mapped over using the Material Mapping Spreadsheet in the Mapping File. If a mapping exists in the mapping 
file, it would be used when transferring data from RISA to REVIT Structure. If not, the original RISA name would be used to 
create new materials in REVIT Structure. Material properties would be updated if the ‘MaterialType’ is set to steel, concrete 
or wood.  

Load Cases 

RISA 3D Basic Load Cases are brought over as REVIT Structure Load Cases. The BLC label in RISA 3D is used as the 
Name of Load Cases in REVIT Structure. Load Categories are not updated at this time. Load Cases are created, updated and 
deleted from RISA to REVIT Structure. 

Load Combinations 

Load Combinations are directly translated into REVIT Structure Load Combinations.  Load Combination Labels, Load Case 
references, Load Case factors are all supported.  The combination type and combination state are also brought over from 
RISA to REVIT Structure. Load Combination information is over-written from RISA-3D to REVIT Structure, ie, existing 
Load Combinations, if any, in a particular REVIT Structure project would be deleted, and new load combinations would be 
created from the information obtained from RISA-3D. 

Point Loads 

RISA-3D joint loads and point loads are brought in as REVIT Structure point loads. All properties including magnitude, 
direction and location are translated. These elements are created if they are not existent in the current REVIT Structure 
project. If an existing element is found, its geometry and properties are updated. If an element was deleted in RISA, it would 
be automatically removed from the REVIT Structure project. 

Line Loads 

RISA-3D distributed loads are brought into REVIT Structure as line loads. All properties including magnitude, direction and 
location are translated. Line load information is over-written from RISA-3D to REVIT Structure, ie, existing line loads, if 
any, in a particular REVIT Structure project would be deleted, and new line loads would be created from the information 
obtained from RISA. This is done to support line loads spanning multiple members in REVIT Structure. 

Area Loads 

3 or 4 noded Area Loads are brought over from RISA-3D to REVIT Structure. All properties including magnitude, direction 
and location are translated. Area load information for 3 or 4 noded loads is over-written from RISA-3D to REVIT Structure, 
ie, existing area loads, if any, in a particular REVIT Structure project would be deleted, and new area loads would be created 
from the information obtained from RISA.  Area loads which are not 3 or 4 noded would be preserved in REVIT Structure. 

REVIT Structure TO RISAFloor 

Floor/ Level Information 

REVIT Structure Levels are brought in as Floors in RISA Floor. Level name and elevation are the properties that are 
supported for various Levels. 
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Grids 

Horizontal and vertical lines are supported along with their labels.  While grid lines in REVIT Structure have their own finite 
start and end location, RISA Floor’s grid lines in each direction span between the most extreme grid points in the respective 
opposite direction. 

Beams, Columns, and Braces 

Family instances with structural usages of column, beam, and braces are supported.  While Columns and Beams are brought 
in as RISA Floor elements, Braces are brought in as supplemental RISA-3D elements. 

The following properties are supported; rotate angle, material type, family type name, start release code, end release code, 
structural type, and element ID.  Material type and physical material properties are also supported.  End reactions, uniform 
studs and camber information is also brought into RISA Floor for beam elements. The user has an option to export explicit 
shape names or redesign lists to RISA Floor. If the ‘Redesign Members’ option is checked on the Export Dialog, then 
Redesign Lists for all members created from REVIT Structure elements are set to the first matching redesign list available in 
RISA Floor. In case, the family type name is not recognized by RISA Floor, it is changed to a 1x1 rectangular concrete 
section. 

Revit beams that are sloped can be brought into RISAFloor, however it must be the highest elevation floor of the model. 

RISA Floor supports pinned and fixed end conditions for beams. Hence, only the following four cases should be specified in 
REVIT Structure :  

End Conditions Fx  Fy Fz Mx My Mz Fx Fy Fz Mx My Mz 

FIXED-FIXED 0 0 0 0 0 0 0 0 0 0 0 0 

PINNED-PINNED 0 0 0 0 1 1 0 0 0 0 1 1 

FIXED-PINNED 0 0 0 0 0 0 0 0 0 0 1 1 

PINNED-FIXED 0 0 0 0 1 1 0 0 0 0 0 0 

If any other combinations are specified in REVIT Structure, the releases would be automatically snapped to the closest match 
amongst the above mentioned cases. The changes would be made to the RISA Floor model only and would not be replicated 
to the REVIT Structure model. 

If the ‘Analyze As’ field of a beam or column is set to “Lateral”, then it would be brought in as a Lateral Element. If set to 
“Gravity”, it would be brought in as a gravity member. Braces are always brought in as lateral elements. All columns sharing 
a node with a lateral beam or lateral wall are automatically converted to Lateral. Along with this, all column stacks that have 
bracings in the bay between them are also automatically converted to lateral. Any element having a lateral loading will also 
be converted to lateral. 

Cantilever Beams 

If either the “Moment Connection Start” or “Moment Connection End” fields of a beam are set to “Cantilever Moment”, then 
the beam would be brought in as a Cantilever in RISA Floor. If both are specified as “Cantilever Moment”, then the beam 
would not be brought into RISA Floor, as this case is practically impossible. The Cantilever beam must have a co-linear 
beam attached to its cantilever end. Also, the properties of the Cantilever beam should be identical to those of the co-linear 
beam. This is to be consistent with the default procedure of creating cantilevers in RISA Floor. 

In-Place Families 

In-place families for beams/framings are supported. In-place families with multiple curves or non-linear curves are supported. 
In order to export/import member information (member shape name, rotate angle, material type, start-end release etc.), the 
individual members constituting an in-place family must be defined as individual family instances (Components).  
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In all other cases, ie, lines, massings etc. only geometry information will be exported. No information would be updated in 
this case. 

Physical / Multi-Level Columns 

If a column spans along multiple levels in REVIT Structure, it will be exported as a physical column to RISA Floor. In RISA 
Floor, all floors/ levels through which this column passes will have a corresponding entry for this column, and a 
corresponding column stack will be added to the RISA Floor model. The offset associated with the actual top level of the 
column is also read and converted appropriately as splice level elevation for relevant columns within the column stack. The 
actual top level offset cannot be entered as a negative number. If so, it would be automatically converted to zero. The splice 
type is also read in for Steel members.  

Actual base level offsets are read for only the bottommost columns in each column stack. For all other columns, the base 
offsets are automatically calculated in RISA Floor to match with the top offsets of other columns in the same stack. The base 
offset for the bottommost columns can be provided as a positive distance from any level. This provides flexibility to model 
structures on uneven terrains like in hilly areas.  

The link will also automatically create splices if the following properties differ for columns in the same column stack: Shape 
Name, Material Type, Material Offset, Function and/or rotation angle. 

Walls 

Wall Elements are supported for RISA Floor. Wall Thickness, openings and function are the properties that are supported. 
Material Type and physical material properties are also supported. If the ‘Structural Usage’ flag is set to 'Shear' or 'Combined' 
for Walls, then it is exported as a lateral element into RISA Floor. In all other cases, walls are exported as Gravity elements.  

For a wall polygon with more than four edges defined in REVIT Structure, an attempt would be made to create a wall around 
its bounding rectangle in RISA Floor.  For walls in REVIT Structure with internal columns will be split up in RISAFloor in 
order to carry the loads accurately. 

Area Load Definition 

Each individually defined area load in REVIT Structure will have its own definition under "Area Load Definition" in RISA 
Floor. However, if more than one set of loops are defined under the same area load in REVIT Structure, then only one area 
load definition corresponding to all loops will be created. All load magnitudes will be listed under the respective category 
(Refer to Load Case Mapping). 

Deck Definitions 

Each individually defined deck/slab will have its own definition under “Deck Definitions” in RISA Floor. At present REVIT 
Structure provides the name of the deck, its thickness, deck direction, concrete strength, weight of concrete and Elastic 
modulus. All other properties are being defaulted to those of standard Composite Decks in RISA Floor. 

Materials 

All steel, concrete and wood materials defined in REVIT Structure are translated into corresponding RISA materials. Any 
other materials (generic etc.), if associated with the walls in the current project are also read into RISA-3D. Materials 
associated with walls are specifically generated under the ‘General’ Material category to match the internal defaults in RISA-
3D. However, the properties of these wall-specific materials might be specified to match any material type.  

All Materials use the Material Mapping File. If a mapping is found on the Materials Spreadsheet of the Mapping File, the 
material properties are preserved in RISA software. If no mapping is found in the mapping file, then new materials are 
created in RISA-3D using the name and material properties available in REVIT Structure. 
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Load Combinations 

RISA Floor has an independent set of values for its load cases and the load categories that it uses for its load combinations. 
However, in both RISA-3D and REVIT Structure, the same load cases are used in Load Combinations.  

To allow REVIT Structure load combinations to be translated to RISA Floor, a special mapping algorithm has been 
embedded in the link. As its first step, it maps REVIT Structure load cases into RISA Floor load cases using the mapping file. 
Following this step, it uses the following table to convert RISA Floor load cases into RISA Floor load categories. Wherever, 
more than one load cases are mapped into one category, the maximum value of the factor amongst all load cases is used as 
the factor for the category. 

Load Comb Category Load Case Name 

DLPre       DL PreComp > 0 , DL PostComp <= 0 

DL          DL PostComp >= 0 

LL          LL and/or LL-Reduce 

LLS         LLS and/or LLS-Reduce 

RLL         RLL and/or RLL-Reduce 

SL          SL 

SLN         SLN 

RL          RL 

OL1         OL1 

OL2         OL2 

OL3         OL3 

OL4         OL4 

  

A ‘Pre Dead Load’ Load Combination is automatically generated in RISA Floor. The loading factor for ‘Pre Dead Load’ 
Load Case is calculated as the maximum factor used for ‘Dead Load’ from all specified Load Combinations. Along with this, 
if the user does not specify any Load Combinations, two other load combinations are added by default. These are ‘1.0 x Dead 
Load’ and ‘1.0 x Dead Load + 1.0 x Live Load’. 

Point Loads 

REVIT Structure point loads are translated into RISA Floor point loads. Point loads can be placed anywhere on the structure, 
and it is not necessary for these loads to lie on top of any element. The local coordinate system flag is not being considered at 
this time as it appears to have no affect on the loads within REVIT Structure. 

Line Loads 

REVIT Structure line loads are brought over as RISA Floor line loads. Line loads can be placed anywhere on the structure, 
and it is not necessary for these loads to coincide with any element.  The local coordinate system flag is not being considered 
at this time as it appears to have no affect on the loads within REVIT Structure. 
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Area Loads 

REVIT Structure area loads are brought into RISA Floor. Polygon area loads and multi-loop area loads are supported in 
RISA Floor. The user can define the area load edges anywhere on the structure and it is not mandatory for these loads to 
coincide with any elements on the structure. 

Decks / Slab Perimeter 

REVIT Structure Decks/slabs are brought in as RISA-Floor Decks. Polygon decks/slabs are supported in RISA-Floor. The 
user can define the decks/slabs anywhere on the structure and it is not mandatory for them to coincide with any element on 
the structure. At solution time, decks in RISA Floor will be automatically clipped to lie within the defined slab perimeters. 

There is an option to create ‘Slab Perimeters’ automatically while going from REVIT Structure to RISA Floor. If this option 
is checked on the Export Dialog, then an attempt is made to create slab perimeters. The link searches for a closed polygon of 
framing inside each defined deck/slab polygon. If a closed polygon of framing is found, slab edges are created on the sides of 
this closed polygon. Perpendicular distance from the mid point of each slab edge to the actual slab/deck outside this edge 
gives the value of overhang for that particular slab edge. In this way, different values of overhang can be specified for each 
slab edge of the same slab perimeter. 

Revit decks that are sloped can be brought into RISAFloor, however it must be the highest elevation floor of the model. 

Openings 

If the ‘Export Slab Perimeter and Openings’ option is checked on the Export Dialog, then openings will be brought into 
RISA Floor. An attempt would be made to find the supporting framing for each opening edge. If a closed polygon of framing 
is found around the opening, then the opening edges would be automatically snapped to it. Perpendicular distance from the 
mid point of each opening edge to the actual opening inside the framing polygon gives the value of overhang for that 
particular opening edge. In this way, different values of overhang can be specified for each opening edge. If no such closed 
framing polygon is found around the actual opening, then the opening would be brought in as-is from REVIT Structure. This 
will produce an error during solution time in RISA Floor. 

RISAFloor TO REVIT Structure 

Floor/ Level Information 

RISA Floor layouts are brought into REVIT Structure as Levels. Level name and elevation are the properties that are 
supported for various Levels. Every layout must have a unique name and elevation value. 

Grid Lines 

Horizontal and vertical grid lines are supported along with their labels. Any grid lines that are horizontal or vertical are over-
written, where as all others are preserved. 

Columns, Beams, and Braces 

RISA Floor Columns and Beams are supported.  Columns, Beams and Braces defined in RISA-3D running under RISA Floor 
are also supported. These elements are created if they are not existent in the current REVIT Structure project. If an existing 
element is found, its geometry and properties are updated. If an element was deleted in RISA, it would be automatically 
removed from the REVIT Structure project. The geometry, location, shape name, rotation, material information and function 
of family instances can be updated from RISA to REVIT Structure. 

RISA shape names are mapped to families corresponding to shapes in REVIT Structure via the shape mapping file. If a 
family corresponding to a particular shape is not already existent in the current project and the auto-load option is checked on 
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the Import Dialog, then the link will run through all available REVIT Structure families. If a match is found for the newly 
imported shape, then the corresponding family would be automatically loaded in the project.  

If a shape name is in both a Column and Beam family in the REVIT Structure project, then it would be distinguished by the 
presence of the “Column” keyword in the Column family and “Framing” keyword in the Framing Family.  

Cantilever Beams 

If either the “Moment Connection Start” or “Moment Connection End” fields of a beam are set to “Cantilever Moment”, then 
the beam is considered as a cantilever beam by the link. If however, both are specified as “Cantilever Moment”, then the 
beam is not considered as a cantilever, as this case is practically impossible. The Cantilever beam must have a co-linear beam 
attached to its cantilever end.  

Existing cantilever beams in REVIT Structure are first deleted, then new cantilever beams are created using information from 
RISA Floor. The properties of the Cantilever beam would be updated identical to its co-linear beam. This is to be consistent 
with the default procedure of creating cantilevers in RISA Floor. 

Physical / Multi-Level Columns 

Each physical piece in every Column Stack in RISA Floor is exported to REVIT Structure at the same location where it 
exists in RISA Floor. The link would automatically break column stacks in REVIT Structure, according to the splice 
elevation entered on the Column/ Floor Spreadsheet. The Top and Bottom Offsets of Physical columns is automatically 
updated by the link. The bottom offsets for the bottommost columns can extend to any distance above/below the Base 
Elevation.  The Column Splice Type (Moment / Shear) is not updated at this time from RISA Floor to REVIT Structure. 

Walls 

RISA Floor walls and openings are supported. Walls are created, updated and deleted from RISA to REVIT Structure. 

The material associated with the Walls in RISA software are mapped over as ‘WallType’ in REVIT Structure. ‘WallType’s 
are mapped over using the Material Mapping Spreadsheet in the Mapping File. If a mapping does not exist in the mapping 
file, the link will try to map the name as it exists in RISA software. If however, this name is not found in REVIT Structure, 
“Generic” wall types would be used. If an existing “Generic” WallType is not found, a new “Generic” WallType is created. If 
a WallType exists and holds a valid material, the properties of this material would be updated using the properties of the 
material associated with the Wall in RISA software.  

Area Load Definition 

Area Load Definitions allow multiple loads under different load cases. Please note that REVIT Structure does not follow this 
pattern. Only one load case can be assigned to one load. If more than one loads cases are defined for one load in RISA Floor, 
then only one of these values would be sent to REVIT Structure. The order of selection of the load case and load value would 
be as follows : LL, DL PostComp, DL PreComp, OL1, OL2, OL3, OL4, Dyn Mass and VL. 

Deck Definitions 

Deck definitions are converted to ‘FloorType’ in REVIT Structure. Only those deck definitions that are referenced by Decks 
in RISA Floor would be created / updated in REVIT Structure. The name of the deck, its thickness, deck direction, concrete 
strength, weight of concrete and Elastic modulus are being supported. 

The link will try to map RISA Floor Deck Definitions to REVIT Structure ‘FloorType’ using the name of the Deck 
Definition used in RISA Floor or a unique internal ID (used to reference the same ‘FloorType’ during multiple round-trips). 
If successful, it will update the information stored in the ‘FloorType’. If however, no mapping is found by name or ID in 
REVIT Structure, “Generic” FloorTypes would be used. If an existing “Generic” FloorType is not found, a new “Generic” 
FloorType would be created. If a FloorType exists and holds a valid material, the properties of this material would be updated 
using the properties stored in the Deck Definition. 



RISA Revit 2010 Link

  27

Materials 

All steel, concrete and wood materials available in RISA software are translated to REVIT Structure Materials. Any other 
materials (generic etc.), would be updated only if they are associated with a ‘WallType’. Materials are created, updated and 
deleted from RISA to REVIT Structure. 

Materials are mapped over using the Material Mapping Spreadsheet in the Mapping File. If a mapping exists in the mapping 
file, it would be used when transferring data from RISA to REVIT Structure. If not, the original RISA name would be used to 
create new materials in REVIT Structure. Material properties would be updated if the ‘MaterialType’ is set to steel, concrete 
or wood.  

Till REVIT Structure 2008, wood materials do not have ‘MaterialType’ set to ‘Wood’. Hence, material properties for wood 
materials would not be updated automatically. The way to update Wood properties is to manually set ‘MaterialType’ to 
‘Wood’ in REVIT Structure before updating from RISA software. 

Point Loads 

RISA Floor joint loads and point loads are brought in as REVIT Structure point loads. All properties including magnitude, 
direction and location are translated. These elements are created if they are not existent in the current REVIT Structure 
project. If an existing element is found, its geometry and properties are updated. If an element was deleted in RISA, it would 
be automatically removed from the REVIT Structure project. Refer to Load Case Mapping for more information on Load 
Cases. 

Line Loads 

RISA Floor line loads are brought in as REVIT Structure line loads. All properties including magnitude, direction and 
location are translated. These elements are created if they are not existent in the current REVIT Structure project. If an 
existing element is found, its geometry and properties are updated. If an element was deleted in RISA, it would be 
automatically removed from the REVIT Structure project. Refer to Load Case Mapping for more information on Load Cases. 

Area Loads 

RISA Floor area loads are brought into REVIT Structure as area loads. All properties including magnitude, direction and 
location are translated. RISA Floor area loads can have any shape and geometry. Area load information is over-written from 
RISA Floor to REVIT Structure, ie, existing area loads, if any, in a particular REVIT Structure project would be deleted, and 
new area loads would be created from the information obtained from RISA Floor. Refer to Load Case Mapping for more 
information on Load Cases. 

Slabs and Openings 

RISA Floor supports two different element types, ie, ‘Slab Perimeter’ and ‘Deck’, where as there is only one element, ‘Slab’ 
in REVIT Structure. In order to keep data consistent during multiple round-trip operations, RISA Floor ‘Decks’ are mapped 
over as REVIT Structure ‘Slabs’. However, default decks would not be brought over into REVIT Structure. Each ‘Deck’ 
should be explicitly drawn in RISA Floor, in order to be send it to REVIT Structure. 

‘Slab Perimeter’ from RISA Floor is never interpreted / created as a ‘Slab’ in REVIT Structure. Any openings that are drawn 
in RISA Floor must overlap explicitly defined ‘Decks’ in RISA Floor in order to be updated in REVIT Structure.  

‘Slab’ and ‘Opening’ elements associated with ‘Slab’ elements in REVIT Structure are over-written from RISA Floor to 
REVIT Structure, ie, existing elements, if any, in a particular REVIT Structure project would be deleted and new elements 
would be created from the information obtained from RISA Floor.  
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Mapping Files 
The link provides additional functionality for user-defined mapping of shape names, materials and RISAFloor Load Cases. 
This mapping is not mandatory for the functioning of the link, however its use is recommended to customize the import and 
export operations. 

The Excel based XML mapping file, “RISA_Revit_Mapping_File.xml” is copied during the RevitRISAComponent 
Installation. The mapping file can be present either in the same location as the DLL or in the folder where RISA software is 
installed. The component will search the DLL location first and the RISA software folder second.  The installation routine 
will place it, by default, in the same folder as the component DLL.  

Shape Mapping 

This spreadsheet consists of three columns : “RISA ShapeName”, “REVIT ShapeName” and “ShapeType”. By default it is 
filled with the mapping for all AISC Hot Rolled Shapes. A couple of examples have been appended at the end of the list for 
demonstration purposes. Any other shapes can be added at any time to this spreadsheet. 

The link would first look for a mapping on this spreadsheet. If not found, it will try to process the shape using internal 
algorithms as mentioned below. If no processing is possible, then the shape name would be transferred ‘as is’ from one 
software to the other.  

In cases when a mapping is not found in the shape mapping file, or concrete and wood shapes there is an internal algorithm 
being mapped during export from REVIT Structure to RISA software. For updating concrete shapes during import using this 
algorithm, the user must follow the general conventions for naming in REVIT Structure. For example, rectangular concrete 
shapes must be named in the format 'a x b' and circular shapes must be named in the format ' c" '. Where a, b, and c are the 
width, depth and diameter respectively. It is important to note however, that REVIT Structure stores rectangular concrete 
shape names as ‘width x depth’ where as RISA-3D stores these names as ‘depth x width’. This behavior is being accounted 
for in the internal mapping algorithm. Wood shapes can be updated during import only through the shape mapping file. 

The following ‘Shape Types’ should be used in the Shape Mapping File. 

Hot Rolled  
WF_SHAPE    Wide Flange     

TUBE_SHAPE      Tube 

PIPE_SHAPE      Pipe 

CHANNEL_SHAPE   Channel 

WT_SHAPE        WT 

DBL_L_SHAPE     Double L 

SNGL_L_SHAPE    Single L 

RECT_SHAPE      Rectangular 

BAR_SHAPE       Bar 

TAP_WF_SHAPE    Tapered Wide Flange 

Wood  
NDS_SHAPE       Rectangular 

NDS_ROUND_SHAPE  Round 



RISA Revit 2010 Link

  29

Concrete  
CRECT_SHAPE     Rectangular 

CRND_SHAPE      Round 

CL_SHAPE        L Shape 

CT_SHAPE        T Shape 

Joists  
KJOIST_SHAPE    K Joist 

LHJOIST_SHAPE   LH Joist 

DLHJOIST_SHAPE  DLH Joist 

SLHJOIST_SHAPE  SLH Joist 

KCSJOIST_SHAPE  KCS Joist 

JOISTGIRDER_SHAPE  Joist Girder 

WOOD_JOIST_SHAPE    Wood Joist 

Material Mapping 

This spreadsheet consists of three columns : “RISA MaterialName”, “REVIT MaterialName” and “MaterialType”. By default 
it is filled with a logical mapping for all default materials and ‘WallType’ that exist in REVIT Structure. Any other mappings 
can be added at any time to this spreadsheet. 

REVIT Structure to RISA 

If the mapping for a particular material or ‘WallType’ exists on the mapping spreadsheet, it would be mapped over with the 
RISA name mentioned on the spreadsheet. In this case, the material properties would be preserved in RISA, and would not be 
over-written from REVIT Structure to RISA.  

If a mapping is not found in the mapping file, the material or ‘WallType’ would be mapped with the same name as that in 
REVIT Structure to RISA Software. In the first transfer, the wall type and material properties are created from REVIT 
Structure to RISA. During updates is the mapping can not be found, the material properties will not be over-written. 

RISA to REVIT Structure 

All materials in RISA would first parse through the mapping file. If a mapping is found on the Material mapping spreadsheet 
or the name is the same in REVIT Structure and RISA, then the properties of the referenced material in REVIT Structure 
would be updated.  

If a mapping is not found in the mapping file and the name of the material is not same in the two software, then an internal 
algorithm using internal IDs is also used to map materials. This algorithm is relevant only during multiple round-trip 
operations and would be rarely applicable. 

If a material is not found in REVIT Structure, then a new material is created using the name and properties coming over from 
RISA software. Please note that Material Properties for wood materials would be updated only if ‘MaterialType’ of existing 
Wood Materials is set to ‘Wood’. In REVIT Structure 2008, the default for ‘Wood’ Materials is set to ‘Unassigned’. 

The material associated with the Wall panels in RISA software are mapped over as ‘WallType’ in REVIT Structure. If a 
mapping does not exist in the mapping file, the link will try to map the name as it exists in RISA software. If however, this 
name is not found in REVIT Structure, “Generic” wall types would be used. If an existing “Generic” WallType is not found, 
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a new “Generic” WallType is created. If a WallType exists and holds a valid material, the properties of this material would be 
updated using the properties of the material associated with the Wall panel in RISA software.  

Available Material Types in RISA Software 

CONCRETE_MATL Concrete Material (Family Instances) 

HOT_ROLLED_STEEL_MATL Steel Material (Family Instances) 

NDS_WOOD_MATL Wood Material (Family Instances) 

GENERAL_MATL General Material (WallTypes) 

Note: 

• RISA MaterialName should NEVER be more than 19 characters in length. 
• There must be one to one mapping for Materials between the two programs, ie, more than one REVIT Structure 

material should not map to the same RISA Material. 
  

If a wall and family instance in REVIT Structure reference the same material, then the same material would be created as two 
different materials in RISA. One entry would be created under Steel, Concrete or Wood Materials which would be referenced 
by the family instance. The other entry would be created under General Materials which would be referenced by the Walls 
(REVIT walls currently reference General Material in RISA software and you can manually change the material type in 
RISA). 

• If a change is made to the properties of this material, then the change should be made at both places for consistency. If 
this is not done, then the properties of the last material transferred would dominate. 

RISAFloor Load Case Mapping 

This spreadsheet consists of three columns : “RISA LoadCaseName”, “REVIT LoadCaseName” and “LoadCaseType”. By 
default it is filled with a logical mapping for all default Load Cases that exist in REVIT Structure. Any other mappings can 
be added at any time to this spreadsheet. 

The reason why this mapping is essential for RISA Floor is that RISA Floor has specific load cases and user defined load 
cases cannot be added to the program. On the contrary, RISA-3D supports user defined Load Cases and hence, it does not 
require Load Case Mapping. 

REVIT Structure to RISA 

The Load Case of every load that is sent from REVIT Structure to RISA is parsed through the Load Case Mapping 
Spreadsheet. If an entry is found on the Load Case Spreadsheet, it is used to find out the associated RISA Floor Load Case 
Name. If an entry is not found on the Mapping Spreadsheet for that particular Load Case, then the name from REVIT 
Structure is used. 

The name obtained at the end of the mapping process (either from the Mapping file, or otherwise) is matched up against 
existing RISA Floor categories. If a match is found, then the load is converted under the found load case in RISA Floor. If 
however, a match isn’t found, the load is transferred under the ‘OL4’ category in RISA Floor. 

The “LoadCaseType” is used to distinguish between RISA Floor loads and RISA-3D loads under RISA Floor. Any load 
cases defined with the “Lateral” keyword as the “LoadCaseType” would be converted into RISA-3D loads and load cases, 
where as all other load cases would be converted into RISA Floor loads and load cases.  

RISA to REVIT Structure 

The Load Case of every load that is sent from RISA Floor to REVIT Structure is parsed through the Load Case Mapping 
Spreadsheet. If an entry is found on the Load Case Spreadsheet, it is used to find out the associated REVIT Structure Load 



RISA Revit 2010 Link

  31

Case Name. If an entry is not found on the Mapping Spreadsheet for that particular Load Case, then the name from RISA 
Floor is used as is in REVIT Structure. 

The name obtained at the end of the mapping process (either from the Mapping file, or otherwise) is matched up against 
existing REVIT Structure load cases. If a match is found, then the load is converted under the found load case in REVIT 
Structure. If not found, a new load case is created in REVIT Structure. 

Available Load Cases in RISA Floor 

DL PreComp  Pre Composite Dead Load 

DL PostComp Post Composite Dead Load 

LL- Non         Live Load 

LL-Reduce   Reducible Live Load 

LLS - Non       Live Load Special 

LLS-Reduce  Reducible Live Load Special 

RLL- Non        Roof Live Load 

RLL-Reduce  Reducible Roof Live Load 

SL          Snow Load 

SLN         Non Shedding Snow Load 

RL          Rain Load 

OL1         Other Load 1 

OL2         Other Load 2 

OL3         Other Load 3 

OL4         Othre Load 4 

Dyn Mass    Dynamic Mass 

VLL         Vibration Load 

Note: 

• RISA Load Case Names should NEVER be more than 11 characters in length. 
• A load case mapping must exist to map loads to RISA-3D running under RISA Floor to REVIT Structure or visa 

versa. 
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Two Way Interaction 
A two file methodology has been implemented to preserve the elements that are added within RISA Software along with the 
elements being brought over from REVIT Structure. A base file created by the RISA program would contain all the 
information about the structure, including new additions or modifications to properties made in RISA software that are not 
directly possible in REVIT Structure. An exchange file that is created by REVIT Structure will contain all information that is 
being exported from REVIT Structure to RISA software. While updating data from RISA to REVIT Structure, the two file 
methodology helps in deleting elements in REVIT Structure that have been deleted in RISA. 

The overall data has been primarily divided into two subsets : 

1. Merge Subset: It refers to the data that is present in REVIT Structure and also in RISA Software. Common examples 
of this data are beams, columns, footings, materials etc. This data can be added and modified in both REVIT Structure 
and RISA Software. The changes to this data can be made in either REVIT Structure or RISA Software.  

2. Preserve Subset: It refers to the data that is present in only RISA Software. Common examples of this data are 
design rules, hot rolled section sets, diaphragms, moving loads etc. 

Please refer to the ‘RISA-REVIT Round Trip’ spreadsheet for detailed information on the elements and data members that 
would be merged or preserved while import and export operations between the two programs. 

Common Tips 

o The base file contains all the data, ie, the data transferred from REVIT Structure along with the new data that is 
created explicitly in RISA. This file can be opened without the exchange file or the REVIT Structure file at any time 
from within the RISA programs.  

o The exchange file contains only the data that is transferred from REVIT Structure. Opening this file using the ‘BIM 
File Import’ Option on the RISA File Menu will merge the data available in this file with the base file referenced 
inside this file, and save the merged data into the base file. Finally it will open the new base file. 

o The base file must be exported to the corresponding exchange file, using the ‘BIM File Export’ Option available on 
the RISA File Menu before importing the file back into REVIT Structure. 

o The base file must be exported atleast once from RISA before a second export is made from REVIT Structure to the 
same exchange file. This helps in hooking up the base file to the exchange file. Alternatively, the base file name 
should be manually selected during the second or any consequent export operation from REVIT Structure to RISA. 
Once the base file name is established using either of the above two methods, the programs always remember it all 
consequent import or export operations. 

o Saving the REVIT Structure File atleast once after an export or import operation helps it to remember the names of 
the exchange and base files chosen during these operations. 

o Not selecting a base file name during an export operation from REVIT Structure (or entering a brand new base file 
name) is an indication to the link to create a brand new base file. Even if there has been a previously associated base 
file, all associations will be broken, and a new base file will be written. 
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 Showing RISA End Reactions 
  

This document shows you how to display your RISAFloor end reactions in Revit. Prior to doing this you need to install the 
RISA Reaction Tags into your Revit project. You can find the steps to do this Installing RISA Tags to Existing Projects.  

  

1. Ensure that you have already Installed your RISA Reaction Tags in Revit (see above)  

2. Within RISAFloor go to the Modify menu and select Global Parameters 

 
3. Click on the Solution Tab. The check box that says Show Factored End Reactions will specify whether or not your 
reactions are exported to Revit as Factored or Unfactored. Set your preference, then click OK 

 
4. Solve your model, then go to the File menu and click Save. When prompted, specify that you would like to Save Results.  

5. Refer to the general RISA Revit link instructions on how to export a BIM Exchange file and import your RISA Model into 
Revit  

6. Go to a Structural Framing Plan view in Revit 

7. Click on the Annotate tab at the top of the screen 
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8. Click on the Tag button on the top of the screen 

 
9. In the upper left corner of the screen, Uncheck the box that says Leader then click the Tags button 

 
10. Within the Tags dialog, scroll down and find the Structural Framing Category. Click on the drop down in the Loaded 
Tags column and select RISA Start Reactions. Then click OK 
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11. Hover over a beam and you will see the reaction tag appear at the “Start” end of the beam. Left click once to apply that 
tag. You can do this to all of your beams: 

 
12. Repeat Steps 9 through 11 to tag the “End” reactions. 

 Installing RISA Reaction Tags 
  

This is a one� time process that will add the RISA reaction tags to your Revit defaults. This will ensure that these tags come 
pre�loaded in all new Revit models you create. To add reaction tags to a model that was created prior to performing this 
installation, see Installing Reaction Tags to Existing Projects 

  

1.Install the RISARevit link (Version 8.0) 

2. Open Revit Structure 2010, and Close any projects that open with it  

3. Click on the Application Menu at the top left corner of the screen, as shown below: 
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4. Click on the Options button in the lower right corner of the Application Menu, as shown below: 

 
  

5. Go to the File Locations tab within the Options dialog.  Take note of the Default Template File path, write it down or 
copy the text to a temporary location. Click on Cancel to exit the Options dialog. 

 
  

6. Using Windows Explorer, navigate to the location of your Default Template File (From Step 5). If this file resides in a 
network location, ensure that you have write �permissions for it. Right �click on the file and select Properties 
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7. Within the Properties dialog make sure that the box marked Read Only is unchecked. Then click OK 

 
  

8. Double �click on the Default Template File to open it within Revit 

9. Click on the Insert Tab at the top of the screen, then click on the Load Family Button that appears on the tool ribbon. 
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10. Within the Load Family dialog, go to the Annotations folder, and then the Structural folder within. Here you will find a 
file called RISA Start Reactions.rfa. Click on this file and click the Open button. 

 
11. Repeat Steps 9 and 10 to load the file RISA End Reactions.rfa 

12. From the Application Menu in the upper left corner click Save and Exit Revit. 

  

  

 Installing RISA Reaction Tags to Existing Projects 
  

This process will help you add reaction tags to Revit projects that were existing prior to completing the instructions on 
Installing RISA Reaction Tags. 

  

1. Open your existing Revit 2010 project 

2. Click on the Insert Tab at the top of the screen, then click on the Load Family Button that appears on the tool ribbon. 
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3. Within the Load Family dialog, go to the Annotations folder, and then the Structural folder within. Here you will find one 
a file called RISA Start Reactions.rfa. Click on this file and click the Open button. 

 
4. Repeat Steps 2 and 3 to load the file RISA End Reactions.rfa 
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Modeling Tips 
Split X-Bracing 

Occasionally you may need to use X-Bracing in your building that consists of three or four split legs. For these occasions it is 
critical that your Revit model and drawings reflect the condition to be built, however this physical model may not agree with 
the analytical model that you use for RISA. The discrepancy is caused by an inherent assumption that engineers make when 
modeling structures, namely that the analytical beams all exist at the same elevation. In reality, if we take the centerlines of 
every beam as analytical members then a W24 would have its analytical member at a different elevation than a W12, 
assuming that these models would be top-justified in real life for a floor system. 

  

Below is an image illustrating how the brace is ideally modeled analytically, and how it should theoretically be detailed (as a 
true concentric connection) 

 
As you can see, the analytical centerlines of the beam, column, and brace all meet at the same location (called the Work 
Point). This eliminates any eccentricity in the connection, thereby eliminating unintended moments in the beam or column. 
The problem comes in when you export this model to RISA: 
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In order to rectify the location of the analytical beam lines, they are all assumed to occur at the Second Floor elevation. The 
physical model for the brace (shown as the black linework) is modeled in its intended location for construction, but the 
analytical model for the brace is a different angle since it must connect to the beam at the second floor. It is common to 
model the second X-brace as two pieces, but if you model them from their workpoints to the physical center of the first brace, 
you will get what you see below: 

 
Revit requires that at least one end of each brace has both the analytical line and the physical member in the same location. 
As such, the analytical lines for the two separate braces intersect at the physical midpoint of the first brace, not at the 
analytical midpoint of the first brace. The physical model is absolutely correct, but the analytical model is wrong, and when 
imported into RISA it will look like below: 
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This will obviously result in undesired behavior in the RISA model, as the braces do not connect to each other. Note that the 
members in RISA line up perfectly with the analytical model from Revit, not the physical model. There is a solution to this 
issue. Although it is not a perfect solution, it is the best known work-around to get both correct construction drawings and a 
correct RISA model from one Revit model. To do this, follow the steps below: 

  

1. Draw both of your braces as full length, intersecting/overlapping each other. This will give you the correct physical and 
analytical geometry for 

both.  
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2. When you export your model to RISA you will get the correct geometry, but no connection between your 

braces.  

3. Add a joint between your braces either by graphically drawing one, or by performing a model merge for intersecting 
members. 

 
4. Your model will now solve correctly in RISA, but you need to modify your Revit model so that the braces are shown 
correctly on your construction drawings. After setting up your framing elevation in Revit, draw a masking region around the 
brace intersection: 

 

5. The masking region will hide the intersection on your drawings. You can then use Detail Lines to sketch the connection as 
you actually want it. Note that your gusset plate isn't modeled, so it won't appear in the 3D Revit model, nor will it be picked 
up during clash detection. 
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Additional Tips 
1. The Redesign Lists that are used by RISA-3D for shape optimization can be edited by the user to limit the redesign 

sizes to match the existent families in REVIT Structure.   
2. In order to preserve Material properties in RISA software, provide a mapping for that particular material in the 

Mapping File. 
3. Level Names should NEVER be more than 32 characters in REVIT Structure. 
4. Two levels should must never have the same name or elevation in either REVIT Structure or RISA Floor. 
5. At least one ‘WallType’ and one ‘FloorType’ with the name ‘Generic – xx”’ (Imperial) ; ‘Generic – xxmm’ (Metric) 

must be present to create new ‘WallType’ and ‘FloorType’. By default these are present in REVIT Structure. 

RISAFloor 

1. RISA Floor allows multiple loads under different load cases to be assigned to any particular point load, line load or 
area load definition. Please note that REVIT Structure does not follow this pattern. Only one load case can be 
assigned to one load. If more than one loads cases are defined for one load in RISA Floor, then only one of these 
values would be sent to REVIT Structure. The order of selection of the load case and load value would be selected in 
the following order : LL, DL PostComp, DL PreComp, OL1, OL2, OL3, OL4, Dyn Mass and VL. 

2. A model must be solved, or ‘explicit shapes’ must be specified in RISA Floor in order to create or update the model 
in REVIT Structure.  Save the results in RISAFloor before exporting the BIM exchange file in order to retain the 
designed shape. 

3. Default splice elevation must be set correctly for each floor on the Floor Spreadsheet in RISA Floor. Some older files 
(before Physical Columns) might not have this value set correctly (might have 0.0). This value needs to be updated 
before creating / updating REVIT Structure models. 

SLAB PERIMETERS and OPENINGS 

RISA Floor supports two different element types, ie, ‘Slab Perimeter’ and ‘Deck’, where as there is only one element type, 
‘Slab’ in REVIT. In order to keep data consistent during multiple round-trip operations, RISA Floor ‘Decks’ are mapped over 
as REVIT ‘Slabs’. The link also provides an option to automatically create ‘Slab Perimeters’ when starting the models in 
REVIT. In this case, a slab perimeter is stitched around all defined ‘Slabs’ in REVIT.  

The following work flow is recommended for consistency of data :  

1. Starting a model in RISA : Define your slab perimeter and decks in RISA Floor. While importing this model into 
REVIT, CHECK the 'Slabs and Openings' checkbox (CHECKED by default). This would bring in RISA Floor 
‘Decks’ as REVIT ‘Slabs’ ; and RISA Floor 'Openings' as REVIT 'Openings'. When sending back this information 
from REVIT to RISA Floor, UNCHECK the 'Slab and Openings' checkbox (UNCHECKED by default). This would 
preserve the slab perimeters and openings that were already defined in RISA Floor. It would still update the deck 
information from REVIT to RISA Floor (properties and geometry). 

2. Starting a model in REVIT : Define your 'Slabs' and 'Openings' in REVIT. Make sure that each ‘Slab’ contains a 
closed framing circuit inside itself. For openings, make sure that each opening is contained within a closed framing 
circuit. When sending this information to RISA Floor, CHECK the 'Slab and Openings' checkbox (UNCHECKED by 
default). This would automatically create the slab perimeter and opening perimeters in RISA Floor. It would also 
bring in 'Slab' properties as 'Deck' properties in RISA Floor. The 'Deck' would be extended all the way to the slab 
perimeters in RISA Floor. When importing this model back into REVIT Structure, you may or may not check the 
'Slab and opening' checkbox. The result in both cases would be the same. 
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Limitations 
REVIT Structure to RISA 3D 

• REVIT Structure Grid Elements that are not horizontal or vertical lines are not supported. 
• REVIT Structure Area Loads that have more than 4 nodes are not supported. 
• Footing Rebar data are not considered in the translation at this time. 

RISA-3D to REVIT Structure 

• In-place families and curved family instances are not updated from RISA to REVIT Structure. 
• Member Structural Type is not updated from RISA to REVIT Structure. 
• Wall Top and Bottom Constraints are not updated from RISA to REVIT Structure. 
• Loads sent to REVIT Structure must be defined in Global directions in RISA-3D. Loads defined with respect to Local 

axis would not be sent back to REVIT Structure. 
• For Load Combination inside another Load Combination mapping, the LC used in another LC must be defined above 

the LC in which it is used. 

REVIT Structure to RISA 3D 

• REVIT Structure Grid Elements that are not horizontal or vertical lines are not supported. 
• RISA Floor supports Floors with absolute elevation greater than or equal to zero feet. Any floor with a negative 

absolute elevation would not be brought into RISA Floor from REVIT Structure. 

RISA Floor to REVIT Structure 

• In-place families and curved family instances are not updated from RISA to REVIT Structure. 
• Wall Top and Bottom Constraints are not updated from RISA to REVIT Structure. 
• Load Combinations are not being brought back from RISA Floor to REVIT Structure. This is due to two separate 

values for load cases and load categories used in RISA Floor. A direct mapping is lacking between the two programs 
which can lead to data loss. 

• Splice Type is not updated at this time from RISA Floor to REVIT Structure. 
• Default Decks and openings drawn on default decks are not created from RISA Floor to REVIT Structure. Decks 

must be drawn explicitly to send them into REVIT Structure. 
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Technical Support 
There is no charge for technical support for all licensed owners of the current version of RISA-3D and/or RISA Floor 
. Technical support is very important to the staff at RISA Technologies. We want our users to able to reach us when they are 
having difficulties with the program. However, this service is not to be used as a way to avoid learning the program or 
learning how to do structural modeling in general. Hours: 9AM to 5PM Pacific Standard Time, Monday through Friday 

For all modeling support questions, please be prepared to send us your model-input file via e-mail / ftp or postal mail.  We 
often will need to have your model in hand to debug a problem or answer your questions. 

E-Mail: support@risatech.com: This method is the best way to send us a model you would like help with.  Most e-
mail packages support the attachment of files. Make sure you tell us your name, company name, serial number, phone 
number, and give a decent problem description.  If you have multiple members, plates, or load combinations, make sure you 
specify which ones to look at. 

Fax Support: (949) 951-5848: When a sketch would aid a problem description, this can be a good way to send your request.  
Please indicate "URGENT" on your fax if you need assistance ASAP.  Provided on the next page is a form you can print to 
FAX your questions to us.  Please provide us with a FAX number for our response. 

Phone Support: (949) 951-5815: Feel free to call, especially if you need a quick answer and your question is not model 
specific and therefore doesn’t require us to look at your file. 

Snail (Postal) Mail to RISA Technologies: This method works fine as long as you can wait for the postal service.  If you 
don't have e-mail, then this is the only way to send us the model that you need help with.  Most people who are in a rush will 
send a floppy disk via overnight mail (e-mail is a lot cheaper and faster, though). 

  

  


